CYF Got Talent ABC Charity Concert and Art Exhibition 2023

Congratulations on the successful holding of the Got Talent ABC Charity Concert and Art
Exhibition on Saturday, October 14, 2023, at Houston Community College. The host, Clemence
Youth Foundation, invited various officials, including US congressmen and their representatives,
Texas state congressmen and senators, as well as community leaders from different ethnic groups
and communities, to gather together. The atmosphere was lively and harmonious, with splendid
performances by children and artists, enthusiastic charity auctions, and high-quality artworks at
the exhibition. The whole concert and art exhibition ended successfully amidst the applause and
cheers of the audience.

US congressmen Troy Nehls, Al Green, Dan Crenshaw, Wesley Hunt, Texas State
Representative Jacey Jetton, Gene Wu, Texas Senator Joan Huffman, and Fort Bend County
Commissioner Andy Meyer, all presented commendation certificates to the CYF Foundation,
praising their outstanding community service, providing ample educational opportunities for
young people, and making significant contributions to community development. Ms. Jingjing
(J.J.) Clemence, the founder and director of CYF, accepted the award on behalf of the
foundation.

Texas State Representative Gene Wu, Fort Bend County Commissioner Andy Meyer, and Texas
Senator Joan Huffman’s representative, as well as Houston Community College (HCC)
Professors and Al division Chair Fidelis Ngang, all delivered speeches at the event, affirming
and praising the significant influence of the CYF Foundation among the local youth in Houston
and encouraging young people to continue their efforts in community development.

One particularly touching moment was Fort Bend County Commissioner Andy Meyer's
unwavering support throughout the event, enthusiastically applauding every performance by the
children and cheering for every charity auction of the foundation. Dr. Thomas McDevutt,
Chairman of The Washington Times, flew from Washington to Houston solely to attend the
event. He, too, applauded every child and cheered for the entire program. In these numerous
guests, we saw boundless love. As long as we have a heart to serve society, we can work
together and contribute.

A major feature of this year's Got Talent ABC was the successful integration of not only the
Chinese community but also people from different ethnic groups, cultures, and languages, all
uniting to contribute to social charity, showcasing the strong cross-cultural gathering ability of
the CYF Foundation and the immense energy of promoting multicultural exchanges and
integration. Indian and African American community leaders were present to support, and they
also posted congratulations for the successful organization of Got Talent ABC.

Communities of Indian descent, Filipino descent, African descent, Native Hawaiian
communities, Chinese communities, and others all united for charity. They not only presented
wonderful music and dance performances but also donated various exquisite items for auction,
including the painting masterpiece "Dionysian" donated by the internationally renowned artist
Jiang Rui, as well as donations from the African and Muslim communities, such as cruise tickets,
and branded violin sets. Graduates from the CYF Youth Department returned every year to



contribute, and everyone worked together to raise funds for charity with all their hearts. Same
goal, same love. Together, we’re stronger! We look forward to creating brilliance together next
year!

The Clemence Youth Foundation (CYF, Nonprofit 501C) aims to provide North American
youth with an opportunity and platform to showcase their artistic talents, cultivate independent
personalities, meet other outstanding young people, and serve the community. You are welcome
to actively support the charity projects of the CYF Foundation and join as a CYF member. Join us
and walk shoulder to shoulder. For detailed information on donations and membership, please
visit the CYF official website: https://clemenceyouthfoundation.org

Your participation is eagerly anticipated. Every small contribution will ignite another
brilliant light of life. May we walk together every step of the way!

For highlights of the event, please visit:

https://drive.google.com/drive/folders/1-
SavYjWsH7t2ZEqC8VogOjlGHY6sWxQa?usp=share link

Many thanks to film director Chen Liang for filming the video of the concert.

https://youtu.be/fsJztj711WY ?feature=shared

We want to thank Walsun Media for filming the video of the program.

https://youtu.be/zUuzcA-XWaQ?si=jsKzV1gmwgaVagZoo (short version)

https://youtu.be/ectAxAOrv4M (longer version)

We appreciate parent Angela Wang for taking the video for the art exhibition.

https://youtu.be/WXnxnTf76 8?si=tbOXXolJulLMnpA-

Let's come together to appreciate the wonderful performances of the children and
artists!


https://clemenceyouthfoundation.org/
https://drive.google.com/drive/folders/1-SqvYjWsH7t2ZEqC8VoqOjJGHY6sWxQa?usp=share_link
https://drive.google.com/drive/folders/1-SqvYjWsH7t2ZEqC8VoqOjJGHY6sWxQa?usp=share_link
https://youtu.be/fsJztj7I1WY?feature=shared
https://youtu.be/zUuzcA-XWaQ?si=jsKzV1qmwgaVqZoo
https://youtu.be/ectAxAOrv4M
https://youtu.be/WXnxnTf76_8?si=tbOXXolJuILMnpA-
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The State of Texas Y House of Representatives

State Representative Gene Wu

presents this Certificate of Recognition to

Clemence Youth Foundation (CYF)
Annual “Got Talent, ABC” Show, October 14, 2023

In hanor of your collaborative endeavors to impire, educare, and rm;mm—r)nmh rkmn,yir I fmmmr develapment, ereative
thinking, and social work expertive, Clemence Youth Found (CYF) is ded by St Gene Wi, Your
wmwavering commitment to reaching ot to young individuals in need, fostering character gmu th, imlﬁﬂ.‘lm self-def :urmtmmun

for the pursuit of their dreams, and equipping them with i tools for soctetal
It is my privilege 1o gxpress my gratitucle and best wishes for a meaningfid and memorable event

TEXAS HOUSE OF REPRESENTATIVES

JACEY JETTON

October 14, 2023

Clemence Youth Foundation

Dear Clemence Youth Foundation:

1 wish you great stiecess as you convens your Annual “Cot Talent, ABC" show this year, The
annual show of celebrating youthul creativity and passion is very appreciated, Thank you for
sipparting and encouraging young performens, nurturing their talents and helping to strengthen
community bonds.

Your commitment 1o support and showease the exceptional talents of young performers is an
excellent service 1o our community. | applaud all your hard work 10 give back 1o the community
and bring the community together in celebration. fident that your leadership
skills will ensure n stronger and better future for the great State of Texas and benefit the mny
young talents in the incoming future,

Office of County Commissioner, Precinct 3
Please do not hesitate 1o contact me If 1 ean ever be of assistance in your mission 1o serve the Andy Meyers

community. | am grateful for your diligence and look forward to your future scess in your Fort Bend County, Texas
endeavors,

e Do clomation
f‘yﬂf" WHEREAS, taday's youth ara the future of our society and have the patantisl o bring new dess,

perspectives, and solutions that can lead 1o positive Impacts across communities and the world
around us, and as such thiy deserve investments in thels education, with guidance and support that

Javey Jetton .
Stale Reprosentative are essontial o bullding strong foundations for a batter future;

House District 26 WHEREAS, communlty leadars ik Jingling Clemence are committed to tackiing the varlety of

challengos and Issues facing our youth by arganizing and cooperatively establishing organizations
that help address a multitude of concerns;

WHEREAS, the Clemence Youth Foundation (CYF) is such an organization with the stated goal to
inspire, educate, and empower youth through character building, innovative thinking, and
enporiance In community service, as young particpants take ownership for

il

WHEREAS, the Foundation Is hosting its “Got Talent ABC Charity” event on October 14,
offer youth acrass our Reglon a platform to demonstrate their varied talents, as well
funds for scholarships and other treasured activities,

NOW, THEREFORE, 1, Fort Bend County Commissioner Andy Meyers, do
horeby recognize Foundation and its for their
commitment ta inspire, educate and empower our youth through their
thoughttul and valued outreach, in Witness Wheraof, | have affised my
signature on this 8% day of October 2023,

W7 2l as

County Commissioner, Precinct 3




Certificate of Special
Congressional Recognition
Presented To

Clemence Youth Foundation

In recognition of the young talents that are able to promote
their art and culture to the comn..nity. Got Talent ABC's is
an incredible charity event that continues to showcase

October 14th, 2023 e 2 /(/ z,vf
Date oA}  Congressman Troy E. Nefils

District 22 - Texas

IN HONOR
of
THE CLEMENCE YOUTH FOUNDATION
For their continued support and outreach of the youth community in the Houston Area. The
Clemence Youth Foundation works to inspire, educate, and empower youth by creating space for
expression, crealivity, and exploration. The many opportunities the foundation offers will

continue to help the next generation thrive.

October 12, 2023

DAL 3 Wesley Tunt
Member ol Congress
TEXAS 38




HOUSE OF REPRESENTATIVES
WASHINGTON, D. €. 20818

AL GREEN

October 14, 2023

Dear Friends:

I would like 1o extend greetings to the Clemence Youth Foundation as you
gather for your 2023 “Got Talent ABC” Show. On behalf of the constituents of the
Ninth Congressional Distriet of Texas, 1 salute all organizers and participants on
their commitment to making this a memorable event,

With great enthusi 1 salute the ( ence Youth Foundation for your
unwavering commitment to inspiring, educating, and empowering youth through
character building, innovative thinking, and social work experience. I congratulate
you on this oceasion as you celebrate your 2023 “Got Talent ABC” Show to
recognize and encourage talented youth in the community.

I look forward to working with the Clemence Youth Foundation on future
endeavors and to continue o serve you well as a Member of Congress. Best wishes
to all for an exciting and enjoyable performance.

Sincerely,

(Ll

Al Green

Member of Congress

Scion of the Enslaved Afvicans ~
Sacrificed to Make America Great

-

U.S. HOUSE OF REPRESENTATIVES
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Texas State Representative Gene Wu gave congratulatory letter to CYF



Texas Senator Joan Huffman sent representatives to give remarks to CYF

Houston Community College Al Department Head Dr Fidelis Ngang
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“Dionysian joy”
(Size: 24" x36”)
Artist: Ray Jiang
Value: $2,500

Violin, bow & case
Value: $2,300

Cruise vacation for two
Value: $2,000

Auction List

Ray liang is an accomplished artist based in the United States. He is
a distinguished member of the Chinese Artists Association, serving
as the President of the US-China Artists Association, and holds a
membership in the Asian Artists Association of New York. Having
graduated from the China Lu Xun Fine Art Academy in the 1990s
with a BA degree, he pursued further education in the United
States, culminating in an MA degree from St. Thomas University in
Houston in 2002. With over three decades of dedicated art
research, Ray Jiang has produced a substantial body of original
works. His artistic expression transcends cultural bounda ries,
adeptly employing abstract and figurative forms along with vibrant
colors to convey profound essence and human emotions.
Additionally, he employs visual language to communicate layers of
meaning beyond culture. Through techniques such as "detection"
and "non-detection," as well as a blend of concrete and abstract
art forms, he offers a unique perspective on universal human
feelings and concepts, epitomizing the artist's inner expression.

Brand new GEWA viclin, bow and GEWA BIO Oblong Violin Case
with original tag.

“Cruise Vacation for Two” certificate. This certificate entitles you to
receive a five day, four night cruise vacation for two to Mexico, the
Bahamas or Western Caribbean. Your cruise includes an interior
stateroom (based on double occupancy), onboard gourmet meals
and snacks, complimentary 24-hour stateroom service, a wide
range of entertainment including Las VegasOstyle shows, dozens of
exciting shipboard activities, plus fabulous international cities to
visit and shop.






CYF Got Talent ABC Charity Concert 2023 Photos
Special thanks to Mrs. Chiu-Fen, the artistic director of the concert.
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10.

11.

CYF Got Talent ABC Charity Art Exhibition 2023 Photos
Special thanks to the art exhibition director Angela Wang and Project Lead Julia Xiao!

. Julia Xiao, 11th

Acrylic, 24x18, <Sweet >
Instructor: Ping Zhao

Julia Xiao, 11"
Oil, 24x18, <Threads of Radiance>
Instructor: Ping Zhao

Grace Kang, Sophomore
Art Design Dress
Instructor: Melia Zhao

Grace Kang,Sophomore
Formal Dress for donation
Instructor: Melia Zhao

Lonny Sui, 7™
Acrylic, 16x20, <Window View>

Eric Xiong, 7%
Pencil, 14x11, <Strong Flyer>
Instructor: Ms. Jeni

Vera Lee, 71
Acrylic, 24x24, Ceiling Mural Painting
Instructor: Dr. Junrui Garcia

Vera Lee, 7"
Pencil, 11x14, <Ballet Point Shoes>
Instructor: Ms. Chu

Meng Chen, 5"
Acrylic, 24x24, Ceiling Mural Painting
Instructor: Dr. Junrui Garcia

Meng Chen, 5th
Watercolor, 14x17, < Bunny>
Instructor: Yan Zu

Leo Gu, 11t
Acrylic, 24x24, Ceiling Mural Painting
Instructor: Dr. Junrui Garcia

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

Leo Gu, 11th
Pencil, 17x14, <Outside the Window>
Instructor: Wei Jia

Stephanie Jiang, 8"
Pencil, 17x14,
Instructor: Haoxiang Zhang

Stephanie Jiang, 8th
Pencil, 17x14,
Instructor: Haoxiang Zhang

Elaine Z, Adult
Acrylic, 20X16, <Winter>

Sophie Zhou, 10th
Oil, 24x18, <Summertime Sass>
Instructor: Ping Zhao

Sophie Zhou, 10th
Qil, 24x18, < Just Like Day One>
Instructor: Ping Zhao

Xiaoyan Guo, 5th
Acrylic, 20x16, <Field View>
Instructor: Esa Song

Xiaoyan Guo, 5th
Acrylic, 20x16, <Field View>
Instructor: Esa Song

Sophia Zhang, 11th
Color Pencil, 16X18, <Lunch Break>
Instructor: Yaowu Zhang

Cindy Sun, 11th
Color Pencil, 20x24, <Tibetan Man>
Instructor: Wenjun Tao

Sophia Zhang, 11th
Color Pencil, 20x16, < Sister>
Instructor: Yaowu Zhang

Violette Ho, 8th



Pencil, 9x11, <Whispers of 24. Joyce Du, 7%
Confidence> Pencil, 11x14, <Piano>
Instructor: Yan Zu Instructor: Yan Zu
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HDMI Switch

HDMI Splitter

HDMI Matrix

AV over IP

Video Wall Controllers
Wired HDMI Extenders
Wireless HDMI Extenders
Audio Products
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